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Summary by Version
This table provides quick access to what’s new in each version. For 
clarification, see About Release Notes.

About Release Notes
Use release notes when upgrading to a newer version to learn about new 
features and changes, and the potential impact on your existing files and 
practices. Release notes are also beneficial if you use or support multiple 
versions.

If you are not upgrading from the most recent previous version, review release 
notes for all interim versions, not just for the version you are installing. For 
example, when upgrading from V1.0 to V1.2, review the New Features and 
Changes, Version Compatibility Considerations, and Bug Reports for V1.1 and 
V1.2.

Version 
(Release)

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related 
Documentation at 
Web Site

Latest Version 
V6.5 (R2006a)

Yes
Details

Yes
Summary

Bug Reports
at Web site

Printable Release 
Notes: PDF

V6.5 product 
documentation

V6.4 (R14SP3) Yes
Details

No Bug Reports
at Web site

V6.4 product 
documentation

V6.3 (R14SP2) Yes
Details

Yes
Summary

Bug Reports
at Web site

No

V6.2.1 (R14SP1) Yes
Details

Yes
Summary

Fixed Bugs 

Known Problems

No

V6.2 (R14) Yes
Details

Yes
Summary

Fixed Bugs 

Known Problems

No
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New Features and Changes
These include

• New functionality

• Changes to existing functionality

• Changes to system requirements (complete system requirements for the 
current version are at the MathWorks Web site)

• Any version compatibility considerations associated with each new feature 
or change

Version Compatibility Considerations
When a new feature or change introduces a known incompatibility with the 
previous version, its description includes a Compatibility Considerations 
subsection that details the impact. For a list of all new features and changes 
that have compatibility impact, see the Compatibility Summary for Signal 
Processing Toolbox.

Compatibility issues that become known after the product has been released 
are added to Bug Reports at the MathWorks Web site. Because bug fixes can 
sometimes result in incompatibilities, also review fixed bugs in Bug Reports for 
any compatibility impact.

Fixed Bugs and Known Problems
MathWorks Bug Reports is a user-searchable database of known problems, 
workarounds, and fixes. The MathWorks updates the Bug Reports database as 
new problems and resolutions become known, so check it as needed for the 
latest information.

Access Bug Reports at the MathWorks Web site using your MathWorks 
Account. If you are not logged in to your MathWorks Account when you link to 
Bug Reports, you are prompted to log in or create an account. You then can 
view bug fixes and known problems for R14SP2 and more recent releases.

The Bug Reports database was introduced for R14SP2 and does not include 
information for prior releases. You can access a list of bug fixes made in prior 
versions via the links in the summary table.
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Related Documentation at Web Site

Printable Release Notes (PDF). You can print release notes from the PDF version, 
located at the MathWorks Web site. The PDF version does not support links to 
other documents or to the Web site, such as to Bug Reports. Use the 
browser-based version of release notes for access to all information.

Product Documentation. At the MathWorks Web site, you can access complete 
product documentation for the current version and some previous versions, as 
noted in the summary table.
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Version 6.5 (R2006a) Signal Processing Toolbox
This table summarizes what’s new in Version 6.5 (R2006a):

New features and changes introduced in this version are

• Taylor Window Function Added

• SPTool Filter Designer Replaced by FDATool

• sgolay Example Improved

• zp2sos zeroflag Parameter Added

• Help for Objects Changed

Taylor Window Function Added
A new function taylorwin for generating Taylor windows has been added.

SPTool Filter Designer Replaced by FDATool
FDATool has replaced the SPTool Filter Designer as the preferred method for 
designing filters for use in SPTool. For details, see SPTool: A Signal Processing 
GUI Suite in the Signal Toolbox documentation.

Compatibility Considerations
The format in which filters are saved differs between SPTool Filter Designer 
and FDATool. When you load an SPTool session with saved filters, you are 
prompted to upgrade your filters to use FDATool format.

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related Documentation at 
Web Site

Yes
Details below

Yes—Details 
labeled as 
Compatibility 
Considerations, 
below. See also 
Summary.

Bug Reports
at Web site

Printable Release Notes: PDF

V6.5 product documentation
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sgolay Example Improved
The example for sgolay has been improved and expanded.

zp2sos zeroflag Parameter Added
A new parameter zeroflag has been added to zp2sos. This parameter is used 
for real zeros that are the negatives of each other. For these zeros it specifies 
whether to keep them together instead of ordering them according to proximity 
to poles. 

Help for Objects Changed
To obtain help for objects, use help object.constructor instead of the old 
help object/constructor. Note that to obtain help for methods, you still use 
help object/method.
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Version 6.4 (R14SP3) Signal Processing Toolbox
This table summarizes what’s new in Version 6.4 (R14SP3):

New features and changes introduced in this version are described here

dfilt (Discrete-Time Filters) Delay Structure Added
A new delay structure (dfilt.delay) has been added to dfilt objects. This 
structure adds latency to any signal filtered with it.

WinTool/WVTool Normalize Magnitude Added
A Normalize magnitude option has been added to the Analysis Parameters of 
WinTool and WVTool magnitude plots.

FDATool/FVTool Plot Displays Improved
The default plots for filter responses have been improved. The y-axis 
autoscaling includes buffer regions around the data and shows only the 
significant data. To see all of the data without any buffer regions, select Full 
view from the View menu.

FVTool Passband Zoom Added
If you have a filter in FVTool that was created in FDATool or from a Filter 
Design Toolbox fdesign object, you can use Passband on the View menu to 
zoom the passband region.

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related Documentation at 
Web Site

Yes
Details below

No Bug Reports
at Web site

No
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Version 6.3 (R14SP2) Signal Processing Toolbox
This table summarizes what’s new in Version 6.3 (R14SP2):

New features and changes introduced in this version are organized by these 
topics:

• FDATool and FVTool Changes

• dfilt Changes

• Spectral Analysis Changes

• Other Changes

FDATool and FVTool Changes

FDATool Spectral Rejection Masks Added
You can draw lines on your filter response in FDATool to indicate rejection 
areas.

FDATool Generated C Header File Complex Filter Support
FDATool now supports generating C header files for complex filters.

FDATool Tip of the Day Added
A new Tip of the Day dialog displays when you start FDATool. It contains tips 
and hints for using FDATool.

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related Documentation at 
Web Site

Yes
Details below

Yes—Details 
labeled as 
Compatibility 
Considerations, 
below. See also 
Summary.

Bug Reports
at Web site

No
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FDATool State Space Filters Support Removed
FDATool no longer supports state space filters. 

Compatibility Consideration. If you load a saved FDATool session that contains a 
state space filter, it is converted to a direct-form II transposed filter.

FDATool/FVTool New Analysis Parameters Magnitude Response Options
Three new options have been added to the Analysis Parameters for magnitude 
response displays. 

• Normalize Magnitude to 1 (0 dB) — displays the magnitude so that the 
maximum magnitude value occurs at 0 dB

• Autoscale axes — automatically scales the response data y-axis

• dB Display Range — If you are not using autoscale and the magnitude 
display is in dB, this allows you to specify the y-axis limits, .

FVTool SOS Filter Coefficients Display Enhancement
The coefficient view in FVTool now displays each section of a second-order 
section filter as a separate filter with its own numerator, denominator, and 
gain.

FVTool Default Phase Units Changed
The default units for the phase response in FVTool have been changed to 
radians. This is consistent with the phasez function.

Compatibility Consideration. You should verify that the FVTool phase plots 
generated by existing code display the desired units.

dfilt Changes

dfilt Coefficients Method Changed
The dfilt coefficients method has been changed to the coeffs method, 
which returns a structure. See the Methods section of dfilt for information.

Compatibility Consideration. You should update any code that uses the 
coefficients method to use the new coeffs method and its returned 
structure.
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dfilt Filter States Changed to Use States Property
You cannot pass filter states (initial and final conditions) via the dfilt filter 
method. You must use the states property. See dfilt for more information.

Compatibility Consideration. You should update any code that passed filter states 
via the dfilt filter method to use the new states property.

Spectral Analysis Changes

spectrogram Function Replaces specgram
spectrogram has been added to replace the grandfathered specgram function. 
If you use this function with no outputs, a surface plot is dispayed, instead of 
an image.

Compatibility Consideration. You should update any code that references specgram 
to use the new spectrogram function. spectrogram uses different default 
values than specgram and the order of the inputs has changed. 

Spectral Analysis Functions Inputs Changed
pwelch (and the other spectrum analysis functions) no longer accept 'half' or 
'whole'. You must use 'onesided' or 'twosided' to indicate the type of 
analysis you want.

Compatibility Consideration. You should update any code that uses 'half' or 
'whole' with spectral analysis functions and instead use 'onesided' or 
'twosided', respectively.

PSD Objects and Function Output Plots Changed
The following functions and methods now generate standard MATLAB plots, 
instead of launching an interactive plot. Refer to the MATLAB documentation 
for information on plots.

• dspdata plot method

• spectrum psd, pseudospectrum, and msspectrum methods
• pburg
• pcov
• periodogram
• pmcov
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• pmtm
• pwelch
• pyulear

Other Changes

gaussfir Function Replaces firgauss
gaussfir has been added to replace the grandfathered firgauss function. 
gaussfir uses parameters that are common to communications systems.

Compatibility Consideration. You should update any code that references firgauss 
to use the new gaussfir.

firpm and cfirpm Inputs Changed
The firpm and cfirpm functions now take function handles as inputs instead 
of strings. 

Compatibility Consideration. You should update any code that uses firpm or 
cfirpm so that it will work correctly with function handle inputs instead of 
string input.

New Demos
The Signal Processing Toolbox demos have been reorganized and a new demo 
on the analysis of a numerically controlled oscillator (NCO) has been added.

Filter Wizard Product Dependency Removed
The Filter Wizard no longer requires the Signal Processing Blockset. You can 
use the Filter Wizard if you have the Signal Processing Toolbox and Simulink 
installed. If you have the Signal Processing Blockset installed, more options 
are available. See dspfwiz for more information.
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Version 6.2.1 (R14SP1) Signal Processing Toolbox
This table summarizes what’s new in Version 6.2.1 (R14SP1):

New features and changes introduced in this version are

• FDATool Changing Order of Filters in Cascaded Filter

• FDATool Exporting Filter Coefficient Files Added

• FDATool Exporting Lattice ARMA filters to C Header Files Added

• FDATool Code Generation Dialogs Buttons Changed

• FDATool Undo/Redo Buttons Removed

• FVTool Numeric Format Selection in Coefficient Viewer

• dfilt ResetBeforeFiltering Property Renamed

• dfilt NumSamplesProcessed Property Display Changed

FDATool Changing Order of Filters in Cascaded Filter
The FDATool Filter Manager now has Up and Down buttons that allow you to 
rearrange the order in which filters are cascaded.

FDATool Exporting Filter Coefficient Files Added
You can now export filter coefficient files in either decimal or hexadecimal 
format from FDATool.

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related Documentation at 
Web Site

Yes
Details below

Yes—Details 
labeled as 
Compatibility 
Considerations, 
below. See also 
Summary.

Fixed Bugs 

Known Problems

No
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FDATool Exporting Lattice ARMA filters to C Header 
Files Added
You can now export Lattice ARMA filters to C header files from FDATool.

FDATool Code Generation Dialogs Buttons Changed
The code generation dialogs in FDATool now include Generate and Close 
buttons, instead of OK, Cancel, and Apply buttons.

FDATool Undo/Redo Buttons Removed
The Undo and Redo buttons have been removed from FDATool.

FVTool Numeric Format Selection in Coefficient 
Viewer
You can now select decimal or hexadecimal numeric format in the FVTool 
Coefficient Viewer. 

dfilt ResetBeforeFiltering Property Renamed
The ResetBeforeFiltering property of the dfilt object has been renamed to 
PersistentMemory. Refer to the dfilt reference page for information.

Compatibility Consideration
You should update any code that uses the ResetBeforeFiltering property to 
use the PersistentMemory property.

dfilt NumSamplesProcessed Property Display 
Changed
The NumSamplesProcessed property no longer displays automatically for every 
dfilt. You can view this property with the following command, where Hd is a 
created dfilt:

get(Hd,'NumSamplesProcessed')

Compatibility Consideration
You should update any code that assumes the NumSamplesProcessed is 
displayed to use the code shown above to display that property.
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Version 6.2 (R14) Signal Processing Toolbox
This table summarizes what’s new in Version 6.2 (R14):

New features and changes introduced in this version are

• Spectral Estimation Objects Changes

• dfilt Enhancements

• Filter States Object Added

• sigwin Enhancements

• FDATool/FVTool Changes

• Function Name Changes

• New Demos

Spectral Estimation Objects Changes

Spectrum Object Added
The Signal Processing Toolbox 6.2 adds a new spectrum object. Spectrum 
objects contain parameter information for a particular spectral estimation 
method (e.g., spectrum.welch). This object provides an improved way to view 
and manipulate spectral estimation parameters. See the spectrum reference 
page and the associated estimation method reference pages for more 
information.

New Features 
and Changes

Version 
Compatibility 
Considerations

Fixed Bugs and 
Known Problems

Related Documentation at 
Web Site

Yes
Details below

Yes—Details 
labeled as 
Compatibility 
Considerations, 
below. See also 
Summary.

Fixed Bugs 

Known Problems

No



Signal Processing Toolbox Release Notes

17

Dspdata Object Added
A new data object dspdata has been added. These data objects contain 
parameter information for spectral data. Available types of data objects are 
dspdata.msspectrum, dspdata.psd, and dspdata.pseudospectrum. These 
objects contain the mean-square spectrum data, the power spectral density 
data, and the pseudospectrum data, respectively. With these objects, you can 
apply methods that calculate certain values or modify the data, such as 
computing the average power, centering the DC value, converting the spectrum 
between one-sided and two-sided, and normalizing the frequency. You can plot 
the data in a new Spectral Analysis plot. See dspdata for information.

Spectrum Options Object Added
A new options object dspopts has been added. This object contains optional 
parameter information for spectrum objects. You create options objects via 
methods on other objects. See dspopts for information.

Spectral Estimation Functions Enhancement 
All of the spectral estimation functions (pburg, pcov, peig, periodogram, 
pmcov, pmtm, pmusic, pwelch, and pyulear) now use the new Spectral Analysis 
plot when no output arguments are specified. For an example of this plot, see 
the spectrum reference page.

psd and psdplot Functions Replaced by psd and plot methods 
The psd method on spectrum objects or plot method on dspdata.psd objects 
replaces the obsoleted psd function.

Compatibility Consideration. You should update any code that uses psd to use the 
plot or dspdats.psd method.

pmem Function Replaced by spectrum.yulear 
The pmem function has been replaced by the new spectrum.yulear object.

Compatibility Consideration. You should update any code that uses pmem to use 
spectrum.yulear instead.
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dfilt Enhancements
• The leading coefficient of the denominator (a0) can not be set to zero.

• New methods have been added to dfilt objects:

- fcfwrite—writes an ASCII filter coefficient file.

- info—displays filter structure, order, stability and linear phase 
information.

• The terminology used for multistage and second-order sections (SOS) filters 
has been clarified and some dfilt method names have been changed. SOS 
filters have sections, where sections compose a single filter. Cascade and 
parallel filters have stages, where each stage is a separate filter. See the 
“Methods” section of the dfilt reference page for information on methods 
related to sections and stages. The new or renamed methods are

- addstage—adds a stage to a parallel or cascade filter object.

- nstages—returns the number of stages in the filter.

- removestage—removes a stage from a parallel or cascade filter object.

- setstage—overwrites a stage of a parallel or cascade filter object.

Filter States Object Added
A new filter states object filtstates with two properties—Numerator and 
Denominator, that contain the filter states for an IIR Direct-form I filter, has 
been added. The states property of a dfilt.df1, dfilt.df1t, dfilt.df1sos, or 
dfilt.df1tsos filter now contains a filtstates.dfiir object, instead of a 
double vector. See filtstates for more information.

Note that you cannot change the values in the Numerator or Denominator 
using this syntax:

Hd.states.numerator = [<data>]

Compatibility Considerations
The sign of the Denominator states for dfilt.df1t and dfilt.df1tsos is 
negated from what it was in previous versions. Refer to the structure diagrams 
shown on the reference pages.

If you use the double command on a filter states object to get a vector of 
double-precision values of the numerator and denominator, the numerator 
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values are listed first, followed by the denominator values. In previous 
versions, the denominator values were listed first.

States saved for SOS objects in previous versions cannot be loaded into the 
current version.

sigwin Enhancements
Two new methods have been added to sigwin objects:

• winwrite—writes an ASCII file containing window weights

• info—displays information about the window object

FDATool/FVTool Changes

FDATool Pole/Zero Editor Added
A new graphical Pole/Zero Editor panel has been added. You can graphically 
edit the filter (move, add, and delete poles/zeros) and see the resulting effect on 
your filter design.

FDATool File Export Enhancements
File->Export changes include adding the ability to export the filter directly to 
SPTool, exporting an ASCII coefficient file instead of a text file, exporting 
cascades and parallel structures, and general improvements to the dialog box.

FDATool New Design Methods Added
FIR Constrained Least Squares (fircls) and complex and nonlinear-phase 
equiripple FIR (cfirpm) filters have been added as design methods.

FDATool Filter Manager Added
A Filter Manager has been added. You can use the Filter Manager to store and 
recall multiple filters in a single FDATool session. You can also use it to 
cascade filters easily.

FDATool/FVTool Analysis Parameters Improved
The Analysis Parameters dialog box has been reorganized and simplified. The 
Frequency Units field has been removed and a Normalized Frequency 
checkbox has been added. (This also applies to FVTool.)
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FVTool Changing Sampling Frequency 
From the command line, you can change the sampling frequency (Fs) for the 
filter(s) in FVTool. See the Controlling FVTool from the MATLAB Command 
Line section of fvtool for more information.

Function Name Changes

remez Function Replaced by firpm 
The remez function has been replaced by the new firpm function.

Compatibility Consideration. You should update any code that uses remez to use 
firpm instead.

cremez Function Replaced by cfirpm 
The cremez function has been replaced by the new cfirpm function.

Compatibility Consideration. You should update any code that uses cremez to use 
cfirpm instead.

remezord Function Replaced by firpmord 
The remezord function has been replaced by the new firpmord function.

Compatibility Consideration. You should update any code that uses remezord to 
use firpmord instead.

tfe Function Replaced by tfestimate 
The tfe function has been replaced by the new tfestimate function.

Compatibility Consideration. You should update any code that uses tfe to use 
tfestimate instead. Note that tfestimate has different default values and 
may produce different results.

csd Function Replaced by cpsd 
The csd function has been replaced by the new cpsd function.

Compatibility Consideration. You should update any code that uses csd to use cpsd 
instead. Note that cpsd has different default values and may produce different 
results.
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cohere Function Replaced by mscohere 
The cohere function has been replaced by the new mscohere function.

Compatibility Consideration. You should update any code that uses cohere to use 
mscohere instead. Note that mscohere has different default values and may 
produce different results.

New Demos
Two new demos have been added:

• Waveform Generation — generates common waveforms, such as pulse 
trains.

• DTMF — generates telephone pad tones.
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Compatibility Summary for Signal Processing Toolbox
This table summarizes new features and changes that might cause 
incompatibilities when you upgrade from an earlier version, or when you use 
files on multiple versions. Details are provided with the description of the new 
feature or change.

Version 
(Release)

New Features and Changes with Version 
Compatibility Impact

Latest Version
V6.5 (R6.5)

See the Compatibility Considerations subheading 
for this new feature or change:

• SPTool Filter Designer Replaced by FDATool

V6.4
(R14SP3)

None

V6.3
(R14SP2)

See the Compatibility Considerations subheading 
for each of these new features or changes:

• FDATool State Space Filters Support Removed

• FVTool Default Phase Units Changed

• dfilt Coefficients Method Changed

• dfilt Filter States Changed to Use States Property

• spectrogram Function Replaces specgram

• Spectral Analysis Functions Inputs Changed

• gaussfir Function Replaces firgauss

• firpm and cfirpm Inputs Changed
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V6.2.1
(R14SP1)

See the Compatibility Considerations subheading 
for each of these new features or changes:

• dfilt ResetBeforeFiltering Property Renamed

• dfilt NumSamplesProcessed Property Display 
Changed

V6.2
(R14)

See the Compatibility Considerations subheading 
for each of these new features or changes:

• psd and psdplot Functions Replaced by psd and plot 
methods

• pmem Function Replaced by spectrum.yulear

• Filter States Object Added

• remez Function Replaced by firpm

• cremez Function Replaced by cfirpm

• remezord Function Replaced by firpmord

• tfe Function Replaced by tfestimate

• csd Function Replaced by cpsd

• cohere Function Replaced by mscohere
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